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Welcome!
Thank you for your interest in becoming Your Health Idaho-certified Consumer 

Connectors (CCs)!  Your participation is key to ensuring that Idahoans have the 

best insurance experience. 

• Because of CCs like you, Idaho consistently ranks among the highest in the 

country for enrollments per capita. 

• YHI-certified CCs include agents, brokers, and enrollment counselors.

• CCs play a vital role in helping Idahoans understand health insurance options 

at YHI.  

Welcome
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YHI Basics
Agenda

Agenda

• Welcome

• History

• State Based Marketplace (SBM)

– How does a SBM work

• Partners

• Open Enrollment (OE) vs Special Enrollment 

Period (SEP) dates

• Basic Processes

– Certification/Decertification

– Account set up

– Account management

– Consumer account set up

– Consumer account management



History
YHI Beginnings
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Idaho’s State-Based Marketplace

The Idaho legislature voted to establish a state-based 

marketplace, now known as YHI, through House Bill 248. 

The bill was signed into law by Governor C.L. “Butch” 

Otter on March 21, 2013.

The legislation established YHI as an independent entity, 

overseen by an 18-member board of directors. The board 

includes agents, brokers, physicians, business owners, 

legislators, and non-profit representatives from Idaho. 

Directors of the Idaho Department of Insurance (DOI) and 

Idaho Department of Health and Welfare (DHW) are on 

the board as non-voting members.

ABOUT YHI



History
What is YHI?
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Health Insurance Marketplaces

To engage and implement the enrollment requirements for newly established 

Qualified Health Plans (QHPs), the Affordable Care Act (ACA) required that 

each state create or subscribe to a Marketplace program, operated by a state, 

the federal government, or a combination of both. 

State-

Based 

Marketplace

State-

Partnership 

Marketplace

Federally-

Facilitated 

Marketplace

States manage all 

marketplace 

functions, with 

federal oversight. 

States partner with the federal 

government, engaging with the federal 

government in operation of certain 

aspects of the federally-facilitated 

marketplace.

States choose to have the 

federal government 

manage all marketplace 

functions in their state.

CREATION OF MARKETPLACES 

• Each state chooses how to design its marketplace. 

• Your Health Idaho is a state-based marketplace. 
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Idaho’s State-Based Marketplace

After using the federal platform for one year, the YHI Board of Directors 

decided in 2014 YHI would transition to an Idaho-run technology solution. 

Because of this, borrowed technology from the federal government was 

used during the 2014 OE to facilitate online enrollment into health plans. 

• Since October 2014, YHI has used and grown its own technology 

solution to create the best experience for Idahoans. 

• A major component of this training is to review the features and 

functionality of the technology system so that you can best assist your 

customers.  

• Updates are made frequently to the system based on feedback, 

experience, and changes in regulations; these are sometimes referred to 

as ‘releases.’

• In designing the technology and state-based marketplace, YHI partnered 

with DHW to use their existing eligibility system to determine consumers’ 

cost savings including Advanced Premium Tax Credit (APTC).  

YOUR HEALTH IDAHO TECHNOLOGY 
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Idaho’s State-Based Marketplace

• Allow individuals in Idaho to compare health insurance and 

buy plans via mail, phone, through an agent, or online

• Display health plan information in a uniform format, using plain language 

for easy comparison

• Work with the Idaho DOI to certify QHPs from Idaho carriers, and ensure 

every plan meets Idaho state standards including the required Essential 

Health Benefit (EHB) package

• Display accurate plan information, facilitate enrollment in health 

insurance plans in the marketplace, and share information with the 

Internal Revenue Service

• Partner with DHW to determine eligibility for APTC and Cost-Sharing 

Reduction (CSR)

YOUR HEALTH IDAHO COMMITMENTS
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Partners

Partners

• Idaho Department of Health and Welfare

– Facilitates and completes APTC and CSR determination 

(financial eligibility)

• Carrier

– Design and sell insurance plans

– Manage payment process and tracking 

• YHI

– Consumer Connectors (Agents/Brokers, Enrollment 

Counselors)

• Assist consumers in completing and managing financial 

eligibility process

• Support and explain insurance options (agents/brokers 

only)



OE vs SEP
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Open Enrollment (OE) happens once per year, between set dates. 

Coverage is effective January 1, 2020.

The date that consumers can begin receiving benefits from their selected QHP 

depends on when they enrolled in the QHP. When a consumer enrolls in a QHP, 

YHI notifies the health plan issuer of the effective date of coverage (the date 

that the consumer should be able to access health benefits). 

Note: Consumers must first pay any premium they owe to the health plan 

before they can receive plan benefits. Open Enrollment for Medicaid/Children’s 

Health Insurance Program (CHIP) occurs throughout the year. Consumers that 

are not already enrolled in a state program can enroll in those programs at any 

time if they are eligible. For clarification please see YHI Policy Manual.

OE vs SEPs

2020 Open Enrollment 

November 1, 2019 - December 16, 2019

https://www.yourhealthidaho.org/policy-manual/
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Special Enrollment Periods in Idaho

Qualifying Life Events (QLEs) for consumers:
• Changes in household size, including birth, adoption, or foster care 

placement; or marriage or divorce

• Death of primary insurance subscriber

• Changes in residence, including permanent moves within the United 

States, with demonstrated coverage of one or more days in the 60 days 

prior to move

• Gaining or continuing American Indian or Alaska Native status

• Changes in eligibility for financial assistance, including gaining APTC 

eligibility or changing CSR level due to change in income

See the YHI Policy Manual for a complete list of Special Enrollment Periods 

(SEPs) and validation requirements.

OE vs SEPs

https://www.yourhealthidaho.org/policy-manual/


YHI POLICY MANUAL



16

Policy Manual Training

Objectives

• History

• What is the Policy Manual

• How to use the Policy Manual

YHI Policy Manual
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History

YHI was initially approved in 2010. The Process Steering Team (PST) 

was created to be a best practice group responsible for identifying:

• Risks

• Policy

• Decisions on processes

• Plan a new program 

They met daily until 2014. The group included stakeholders from our 

external partners to ensure accuracy and validity.

Much of the YHI policy history is rooted in the analysis from this group, 

a comparison to the Code of Federal Regulations (CFR), Center for 

Medicaid & Medicare Services (CMS) guidance, and Idaho-specific 

goals and regulation.

YHI Policy Manual
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This is one of the only consumer-facing policy manuals in the country. 

It is one of the best tools YHI and our partners utilize in order to speak 

a common language and support consumers. 

These rules align with federal and state regulations and requirements. 

They are made Idaho-specific to best support Idahoans. 

Consumer Connectors, consumers, DHW, and carriers should 

reference the YHI Policy Manual in their enrollment process. 

What is the Policy Manual?

YHI Policy Manual
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The YHI Policy Manual reflects federal and state regulations, it is regularly 

updated and reviewed based on changes in administration. Additionally, 

the policy manual is reviewed for adjustments in human behavior or 

trends, as well as changes in process between our partners. 

The group reviewing and approving the policies has been renamed the 

Policy Steering Team, or PST, and they meet monthly. The representation 

is the same as initially included but has encompassed a few more 

representatives across fields. 

YHI Policy Manual

What is the Policy Manual?

The New Policy Steering Team



Consumer Account 

Management

New Account Set-Up
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There are two ways that a consumer can apply for coverage on Your Health 

Idaho. Below is a chart that you can use when helping consumers. 

Application Linking

Your Health Idaho Applications

Applying for Cost-Savings Applying without Cost-Savings

Who? 

Idahoans who want to determine their 

eligibility to enroll in coverage on Your Health 

Idaho with a premium tax credit should apply 

for cost-savings.

Idahoans who want to determine their ability 

to enroll in a qualified health plan on Your 

Health Idaho without the premium tax credit or 

Cost-Sharing Reduction (CSR). 

What 

information is

required? 

Consumers will be asked for information 

including names of household members, 

Social Security numbers, dates of birth, 

citizenship status, and information about 

income. 

Consumers will be asked for information 

including names of household members, 

Social Security numbers, dates of birth, and 

citizenship status.

Where is the 

application 

processed? 

Consumers that apply for cost-savings are 

taken to an application processed by the 

Idaho Department of Health and Welfare 

(DHW) through an online portal known as 

idalink. 

These applications are processed by Your 

Health Idaho. 



22

Account Creation

NEW ENROLLEES

Based on feedback and poor consumer experiences reported, YHI updated the 

system to automate linking DHW eligibility to YHI enrollments. 

Because of this update: 

• For new consumers, the path to create an account will now START with YHI. 

This is a process change different than in the past and will significantly reduce 

the amount of applications to be linked. 

• Creating an account with YHI and DHW should reflect consistent information

❑ YHI - Primary account holder

❑ DHW - Primary account holder = Primary Tax filer = First consumer 

on the application

NOTE: All demographics should be identical on both accounts to include 

the primary account holder. 
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NEW ENROLLEES

Step 1: Create an account with YHI (www.yourhealthidaho.org) 

• Create non-financial application

• Designate Agent of Record (AOR)/enrollment counselor

• Review Pre-eligibility and Shop for Plans

• Add plan to cart

Step 2: Create an account with DHW

• Complete authorized rep request with consumer

• Process a financial application to determine:

- Medicaid/CHIP

- APTC/CSR

Account Creation

https://www.yourhealthidaho.org/
http://www.yourhealthidaho.org/
https://idalink.idaho.gov/
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NEW ENROLLEES

Step 3: Once YHI receives the financial application, both AOR and 

consumer will receive notification to act. 

• Enroll the member and make the binder payment.

Step 4: Carrier confirms enrollment and sends monthly updates through 

electronic data interface for reconciliation purposes.

Account Creation



Consumer Connector Tools
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Designations

• Consumer Connectors (CCs) who set up the consumers account must 

designate themselves and accept the designation.

OR
• CCs working with consumers must advise the consumer to add them 

as the designated agent of record (AOR).

- AORs must accept the designation in order to receive commissions 

and have permission to support the consumer via phone, email, or 

portals.

Consumer Connector Tools
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How to designate
Step 1. From the consumers dashboard click Find Local Assistance

Step 2. Click “Find a Certified 

Agent or Broker Near You” or

“Find a YHI Certified Enrollment 

Counselor Near You”

Note: To search for an Enrollment 

Counselor, search by location or by 

Organization Name.

Designations

Consumer Connector Tools
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How to designate
Step 3. To locate an AOR, Search by Location or Search by Name

Designations

Consumer Connector Tools
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How to designate
Step 4. Click name of the agent highlighted in blue 

Designations

Consumer Connector Tools
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How to designate
Step 5. Click Continue

Designations

Consumer Connector Tools
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How to designate

Note: The consumer must agree and check the following statements. 

Step 6. Click each check box

and enter consumers name in 

the e-Signature.

Step 7. Scroll down to

click  Confirm.

Designations

Consumer Connector Tools
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How to designate
Step 8. Click Close

Designations

Consumer Connector Tools



ACCEPTING 

DESIGNATIONS
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Accepting the Designation
Step 1. Log-in to Agent Portal

Step 2. Click Pending Individuals under Quick Links

Consumer Connector Tools
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Accepting the Designation
Step 3. Click the consumers name in blue or gear under “Actions”

Clicking the gear Icon will allow to accept from a drop down.

Consumer Connector Tools
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Accepting the Designation
Step 4. Click Accept   

Consumer Connector Tools



Consumer Connector Tools
Book of Business
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Book of Business

• About the YHI Book of Business (BoB)

• Efficient & Effective BoB Practices

– Download your BoB report

– Navigating your BoB report

– Tips and tricks

• Conducting a BoB Transfer

Objectives
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YHI Book of Business

What is it?

Book of Business

• Client management system 

• Formatted in a MS Excel spreadsheet

• Contains a list of your designated consumers

• Contains data specific to the consumers YHI enrollment
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YHI Book of Business

Why should you use it?

Book of Business

• Organize and prioritize consumer cases

• Easily navigate the consumer’s enrollment needs

• To better assist your consumer in the enrollment process

• To maintain closer relationships with highly valued consumers

• Simultaneously nurture less urgent consumer cases
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Efficient & Effective BoB Practices

Daily downloads

• Log into your YHI Portal

• Click the “Individuals” drop down in the horizontal tool bar

• Select “Active Individuals”

Book of Business
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Efficient & Effective BoB Practices

Daily downloads

• A new page containing the list of active individuals in your 

Book of Business will populate

• Click the “Export as Excel” below the horizontal search bar 

to download your daily Book of Business report

Book of Business
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Efficient & Effective BoB Practices

Daily downloads

• A disclaimer will pop up

• Click “Yes” to proceed 

• The report will 

download, and the icon 

will appear at the 

bottom-left of your 

browser screen

• Click the icon to open 

the report 

Book of Business
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Efficient & Effective BoB Practices

Navigating your report

• The report will indicate:

▪ Consumer’s name

▪ Consumer’s contact information

▪ Details about the household application 

▪ Details about the plan in which the consumer is enrolled

Book of Business
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Efficient & Effective BoB Practices

Navigating your report

• Each column contains 

different information

• For example, “Current 

status” contains 

information regarding the 

status of the consumer’s 

account

Book of Business
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Efficient & Effective BoB Practices

Tips and Tricks

• Navigating your BoB is much easier when you have the 

proper settings.

• The following slides will teach to how to adjust your 

spreadsheet for easier navigation, widen columns, filter 

data, temporarily hide information, and permanently remove 

unnecessary data.

Book of Business
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Efficient & Effective BoB Practices

Tips and Tricks

Step 1:“Select All”

• Use to adjust the entire 

worksheet

• Click the diagonal triangle at 

the top left to highlight the 

entire spreadsheet

• Every cell will be highlighted, 

except for the first cell

Book of Business
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Efficient & Effective BoB Practices

Tips and Tricks

Step 2: “AutoFit”

• Use to evenly widen every 

column

• Click the “Home” tab

• Click “Format” in the top-

right of the tool bar under the 

“Cells” section

• Select “AutoFit Column 

Width” in the drop-down 

menu

Book of Business
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Efficient & Effective BoB Practices

Tips and Tricks

Step 3: “Filter”

• Use to sort the data contained 

in each column

• Click the any cell in the first row

• Click “Sort & Filter” in the top-

right of the tool bar under the 

“Editing” section

• Select “Filter” in the drop-down 

menu

Book of Business
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Efficient & Effective BoB Practices

Tips and Tricks

Step 4: “Bold”

• Use to distinguish the top title 

row from the data below

• Click the number “1” to highlight 

the title row

• Click “B” in the top-right of the 

tool bar under the “Cells” 

section

• These steps can be used to 

bold any information within the 

spreadsheet

Book of Business



51

Efficient & Effective BoB Practices

Tips and Tricks

Step 5: “Pane Freeze”

• Use to keep the title row 

visible as you scroll 

throughout the spreadsheet

• Click any cell in the title row 

• Select the “View” tab above 

the tool bar

• Click Freeze Panes

• Select Freeze Top Row

Book of Business
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Efficient & Effective BoB Practices

Tips and Tricks

Step 6: “Hide Data”

• Use to temporarily hide 

data you don’t need now, 

but may want later

• Click and highlight the 

column(s) or row(s) you 

wish to hide

• Right-click using your 

mouse to open the drop-

down menu

• Select “Hide”

• To unhide, follow the same 

steps. Then, click “unhide”

Book of Business
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Efficient & Effective BoB Practices

Tips and Tricks

Step 7: “Remove Duplicates”

• Use to remove duplicate 

households

• Follow steps to “Select All”

• Click the “Data” tab above the 

tool bar

• Click “Remove Duplicates” 

Book of Business
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Efficient & Effective BoB Practices

Tips and Tricks

Step 7: “Remove Duplicates”

• Click “Unselect All” 

• Check mark the boxes next to 

the following data fields:

✓ Numbers

✓ First Name

✓ Phone Number

✓ Email

• Click “OK” when finished

• Households with identical 

data in the above fields are 

often duplicates due to 

various factors

Book of Business
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Book of Business Transfers

Book of Business

• Book of Business (BoB) transfers are conducted when an 

agent or broker wants to sell or transfer their Book of 

Business to another YHI certified agent

• YHI recognizes an agent-to-consumer relationship

• The transaction can be conducted between two agents, 

agent to agency, or agency to agency
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BoB Transfer Requirements

Book of Business

1. Complete the Book of Business Transfer Request form

• The “selling” and “purchasing” agents must sign

2. Submit a list of consumers in excel sheet format

• If transferring entire BoB, the consumer list is not 

required

3. Email documents to Connectors@yourhealthidaho.org

Book of Business Transfers
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Special Circumstances

Book of Business

• For agencies that own the BoB upon termination of an 

agent, the agency must submit the signed contract 

indicating agency ownership

• Consumers have the right to choose their preferred Agent 

of Record (AOR)

• YHI certified agents leaving an agency while maintaining 

YHI certification, must update YHI by contacting 

Connectors@yourhealthidaho.org

Book of Business Transfers
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Maintaining YHI Certification after BoB Transfer

Book of Business

• Agents leaving an agency must complete the following:

• Update YHI by contacting Connectors@yourhealthidaho.org

• Update their YHI agent portal log-in credentials, if email has 

changed

• Update their YHI agent portal profile with their new contact 

information (email, phone number, office address, etc.)

• Update their log-in credentials for Edvance360, the learning 

management  system (LMS), if email has changed

Book of Business Transfers

mailto:Connectors@yourhealthidaho.org
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Our Partners

Resources

Additional resources and tools for Consumer Connectors can 

be found within the Our Partners section of the YHI website.

• From the YHI home page, scroll to the very bottom.

• Our Partners is located under ”Opportunities”

• www.yourhealthidaho.org > Opportunities > Our Partners

https://www.yourhealthidaho.org/our-partners
https://www.yourhealthidaho.org/our-partners
http://www.yourhealthidaho.org/
https://www.yourhealthidaho.org/our-partners
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YHI Systems and Tools for Consumer Connectors

• Edvance360 (LMS)

– All PowerPoints and trainings

– Important dates

• YHI Policy Manual, Code of Federal Regulations, state regulations

• YHI Website

• Consumer Support: support@yourhealthidaho.org

OR 1-855-YH-IDAHO (1-855-944-3246)

• Consumer Connector support: connectors@yourhealthidaho.org

Resources

mailto:support@yourhealthidaho.org
mailto:connectors@yourhealthidaho.org


YHI Notices



62

YHI Notices

Secure In-Box

YHI Book of Business

• Notifications regarding certain changes to your consumer’s 

account will be sent to via your secure inbox

• Be sure to check your inbox regularly

• Message cannot be deleted from your secure inbox

• The following list contains a few  reasons you may receive 

a notification:

– Changes in Eligibility

– Status change: Non-Financial to Financial

– Financial: Life Changing Event (LCE) Notice

– LCE: Loss of Coverage

– LCE: SEP Granted
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YHI Notices

Daily Notice Summary

YHI Book of Business
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YHI Notices

Daily Notice Summary

YHI Book of Business



New Account Management
Financial Application
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• All consumers who want to apply for APTC or CSR must submit an 

application with DHW, https://idalink.idaho.gov/

• The application process can be done completely online through the 

idalink system or by calling 1-877-456-1233. All contact with DHW 

should be made via 1-877-456-1233 unless a specific number is listed 

on the notice

• Have your client designate you as the Agent Authorized Representative 

at DHW (this designation does not apply to YHI accounts)

• The Agent Guide to idalink is available on the Partner Tools page at 

YourHealthIdaho.org

Apply for Cost-Savings 

Financial Eligibility

https://idalink.idaho.gov/
https://www.yourhealthidaho.org/partner-tools-and-information/
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Apply for Cost-Savings 

Consumers need to provide information about each 

member of their tax household to apply. Tell consumers 

to be prepared with the following information:

• Birthdates

• Social Security numbers (or document numbers for legal immigrants)

• Citizenship or immigration status

• IRS tax returns for previous years

• Employer and income information (i.e., pay stubs, and W-2 forms)

• Information on current health insurance or employer-sponsored coverage 

for which anyone in their household is eligible

Prepare to Apply
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ACCOUNT MANAGEMENT TOOLS

Managing personal information

Apply for Cost-Savings 

DO DON’T

Use an email account that the 

consumer has access to

Don’t create a new account that the 

consumer doesn’t have access to

Help the consumer to set up 

password manager, like LastPass or 

KeyPass

Don’t hand the consumer a paper 

copy of all their passwords and 

logins 

Set up your own password 

manager, like LastPass, Keypass, or 

other similar programs

Don’t store consumers’ information 

in writing 

Send secure emails to support or 

connectors@yourhealthidaho.org

Don’t send PII unprotected to YHI 

(ie; SSN, first and last name, DOB, 

addresses, etc.) 

Learn more about how to secure 

and protect both your and your 

consumers’ PII

Don’t assume that emails are 

always secure. 

mailto:support@yourhealthidaho.org
mailto:connectors@yourhealthidaho.org
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ACCOUNT MANAGEMENT TOOLS

Managing personal information

Privacy & Security Standards
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• To set up a consumer account, go to idalink.

• Click Need to Register?

Apply for Cost-Savings 

The Application Process

https://idalink.idaho.gov/
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• Enter the consumer’s information and click Register.

Apply for Cost-Savings 

The Application Process
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click Start Now in the Apply for Health Coverage Assistance section. 

Apply for Cost-Savings 

The Application Process
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Apply for Cost-Savings 

Click Next to continue.

The Application Process
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Apply for Cost-Savings 

Click Next to continue.

The Application Process
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Apply for Cost-Savings

The You May 

Need section 

provides tips for 

what information 

the consumer 

needs to 

complete each 

section, along 

with a time 

estimate.  

Click Next to continue.

The Application Process
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Apply for Cost-Savings

Have the consumer select you as their Agent Authorized Representative.

Select Yes and select your name in Agent Name. 

The Application Process: Agent Authorized 
Representative
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The consumer must select 

which method of 

communication they prefer.

IMPORTANT: DHW does 

not send consumer notices 

via email, but YHI does. If 

email is not selected as the 

preferred method of 

contact, only paper copy is 

sent from YHI, which delays 

the notification process.

Apply for Cost-Savings 

The Application Process: Contact Information
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Apply for Cost-Savings

Once the consumer enters their personal information, verify their identity. 

The application uses Experian (a credit reporting company) to generate 

address and credit-related questions to verify identity.  

The Application Process: Identity Verification
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Apply for Cost-Savings

If the consumer’s 

application is entered 

correctly, a confirmation 

appears that their identity 

is verified. Move to the 

next part of the application 

process.

The Application Process: Identity Verification
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Apply for Cost-Savings

If the system is unable to 

verify identity 

automatically, follow the 

on-screen instructions for 

the manual verification 

process.

The Application Process: Identity Verification 
Failed
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Apply for Cost-Savings

Enter information about 

members of the consumer’s 

household and whether they are 

applying for coverage.

The consumer must include all

household members in this 

reporting section.    

The Application Process: Your Household
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Apply for Cost-Savings

Provide information about the 

consumer’s tax status.

It is not a requirement to have 

filed taxes in previous years, but 

the consumer must file taxes in 

the upcoming year to receive the 

premium tax credit for the 

current enrollment period.  

The Application Process: Tax Status
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Apply for Cost-Savings

Enter details for each member of the consumer’s household. 

The Application Process: Member Profiles
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Apply for Cost-Savings

Follow the prompts on-screen to enter the consumer’s information about 

household income. Enter income from a job, self-employment, and other 

sources.

The consumer should consult a tax professional if they have further questions 

about what should be counted as income.

The Application Process: Household Income
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Apply for Cost-Savings

After completing income, a 

summary page appears with 

the annual household 

income that is used by 

DHW to determine the 

consumer’s eligibility for 

cost-savings programs. 

The Application Process: Income Summary
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Apply for Cost-Savings

The last section of the application asks about access to other types of 

private or public health coverage for which they may be enrolled or eligible.

The Application Process: Additional 
Questions
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Apply for Cost-Savings

Review the application information in detail because once submitted, the 

consumer cannot edit or view the information online.  

Once the information is confirmed, it is highly recommended that you print two 

copies (one for you and one for your client). The information is needed again 

after the application is received by YHI. 

Review the Application
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Apply for Cost-Savings

Read the agreement, enter the eSignature, and click Submit Your Application to 

continue. The consumer receives an email confirmation that the application was 

received.

The consumer might be contacted by DHW if any additional documents are needed 

to process the eligibility determination. If documents are not provided in the 

specified timeframe, consumers will lose their eligibility for APTC/CSR.

Submit the Application
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Apply for Cost-Savings

DHW determines consumers’ eligibility for Medicaid, CHIP, and the premium 

tax credit (APTC) or CSR.

If a consumer is eligible for a premium tax credit or CSR, the application 

information is transferred to the consumer’s YHI account. During Open 

Enrollment, this allows the consumer to shop, compare, and choose a QHP 

with the applicable cost-savings program. 

NOTE: DHW will process and transfer the consumer’s application to YHI 

in two to ten (2 to 10) days.    

Verification & Eligibility Determination
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Apply for Cost-Savings

DHW notifies the consumer of their eligibility determination. If eligible for cost-

savings programs, the consumer receives a notice via email and/or mail from 

YHI to link the DHW application to their YHI account. 

The designated agent, broker, or enrollment counselor is also notified 

when action is required. Consumer Connectors receive a daily digest of 

notifications that are sent to their designated clients. Log in and check the Inbox

to view these notifications.

YHI recommends that agents, brokers, and enrollment counselors follow up with 

their customers 2-5 business days after the DHW application to see if the 

consumer has received an email to link the account. Let the consumer know you 

can assist with the linking process. 

Consumer Notification of Eligibility

IMPORTANT: If you attempt to use the consumer’s special URL with your 

own agent or broker account, you might void the completed application. It 

is CRITICAL the consumer uses the URL with their own account.  



Linking Financial Eligibility

Access Codes, Linking, and 

Automation
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Includes these topics:

• Link a DHW Application to Your Health Idaho with an Access Code

• Review consumer eligibility results.

Note: If account creation and application is done at YHI, 
application  from DHW should automatically link to consumer’s 
account. 

Link the DHW Application to Your Health Idaho 

Link a financial application
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• After the consumer applies for cost-savings, DHW makes the determination 

for eligibility. Once APTC eligibility is determined, DHW sends an account 

transfer to YHI (approx. 2-10 days).

• YHI sends the consumer a notification stating the APTC determination is 

received. The notification contains a link and an access code that links the 

information in the DHW account to the YHI account.

IMPORTANT: If email is not selected as the preferred method of contact, only a 

paper notice is sent, which delays the notification process.

Application Linking

Link a DHW Account to a Your Health Idaho Account
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Application Linking

This example shows the notification from Your Health Idaho for the consumer’s 

APTC determination. The consumer clicks or enters the link in a browser to open 

YourHealthIdaho.org. 

Notification of APTC and Access Code
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Enter the access code from the notification you receive in the 

consumers YHI account inbox.

You can do this by following the link in the notification or by 

going to YourHealthIdaho.org and clicking on the Access Code 

tab or “Have an Access Code? Click Here” on the home page. 

Application Linking

Use the Access Code
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The consumer answers verification questions, which can include their name, 

DOB, phone number, email address, gender, county of residence, and total 

members in household. This information can be found on the copy that was 

printed for application with DHW(mentioned in previous slide).

Application Linking

Verify Identity
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Application Linking

Access Code Could Not Be Processed Message

If the link is unsuccessful, an error message will appear. Email 

support@yourhealthidaho.org for assistance with any error you receive during 

this process.

mailto:support@yourhealthidaho.org
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Enter and save the consumer’s 

communication preferences. The 

dashboard opens.

NOTE: If email is not the primary 

method of contact, the consumer 

receives only paper notices in the 

mail.

The DHW application is now 

linked to the consumer’s account 

at Your Health Idaho.

Application Linking

Successful Links



Consumer Eligibility Results
YHI Consumer or Agent Portal
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Review Eligibility Results

You can see the consumer’s eligibility results in their linked account. To view the 

results, log in to your account, select Individuals > Active Individuals.

Search for the consumer by name, application type, current status, next steps, due 

date, issuer, or coverage year. 

1

2

Search the Consumer’s Account
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Review Eligibility Results

To continue, click 

Individual View in 

View Individual 

Account.

View the Consumer’s Account

After you enter the search criteria, a scrollable list will populate below. To view an 

individual consumer, click their name or Account on the bottom toolbar. 
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Review Eligibility Results

On the consumer’s dashboard, click Eligibility Details to view their eligibility results.

View the Eligibility Results
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Review Eligibility Results

Financial eligibility is determined by DHW.at the individual level because there are 

multiple coverage options available between Medicaid, CHIP, and the premium tax 

credit. In some cases, parents and children might qualify for different programs. 

For example, in a household that is at 180% of the Federal Poverty Level, parents 

might be eligible for the premium tax credit, but their children might be eligible for 

CHIP. 

In these cases, DHW notifies the family by mail that the parents qualify for 

the premium tax credit and the children qualify for CHIP

Families with Differing Eligibility Results
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Review/Survey

Next steps

Review/Survey

– Break

– Complete in-person training

– Complete online survey

– Complete all required online 2020 

Consumer Connector courses


